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Введение 
 
Мультимедиа-системы (ММС) суть системы  обработки и представления 

мультимедиа-данных (ММД) и имеют два аспекта - аппаратный и программ-

ный. В  данной работе рассматривается последний, причем как на пользова-

тельском (приемы  создания и обработки ММД с помощью  ПО сторонних 

разработчиков) уровне, так и на уровне программиста (технологии про-

граммной реализации стандартных функций обработки ММД). Программи-

рование в основном ориентировано на ОС Windows, переход на UNIX-

подобные ОС облегчен использованием сред программирования Borland Ku-

lix.  

Усвоенные приемы разработки ПО  реально полезны при создании про-

грамм обработки данных картографии, аэро- и космической съемки, системах 

автоматизированного проектирования, подготовке к распознавания образов 

(поиск и выделение границ) и др. При реальном программировании исполь-

зуется система C++Builder фирмы Borland Int., причем полученные навыки 

ценны  при переходе на Delphi  (в обоих системах разработки приложений 

совпадают имена объектов и компонентных функций, разница заключается 

лишь в синтаксисе языков программирования); при этом переход на Borland 

Kulix (для ОС Linux) максимально облегчен. Особое внимание обращено на 

особенности программирования (включая типовые ошибки) графических 

приложений и пути повышения производительности (что необходимо для 

создания профессиональных приложений). 

При работе со звуковыми и видеоданными использованы известные (рас-

пространенные) пакеты сторонних разработчиков, хорошо зарекомендовав-

шие себя в практической работе. 
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1 Лабораторная работа 1.  Создание простых программ  
для визуализации файлов изображений и видео 

 
1.1 Цель работы – приобретение практических навыков в создании ПО 

(‘вьюверов’) для просмотра (визуализации) растровых изображений и аудио-
видеофайлов с использованием систем быстрой разработки приложений Del-
phi и C++Builder фирмы Borland Int. в среде ОС Windows [1,3]. 

 
1.2 Теоретические основы. Любые видеоданные в конечном счете пред-

ставляют  собой  последовательность блоков информации о каждой точке 
изображения (пикселов, pixels - picture element); сжатие информации (без по-
тери качества или с некоторой потерей оного) необходимо лишь для умень-
шения объема дискового пространства, необходимого для сохранения соот-
ветствующего файла. При этом каждый раз при считывании файла происхо-
дит декомпрессия файла, при сохранении – повторная компрессия (согласно 
заданной технологии сжатия).  
В системах Delphi/C++Builder определен компонент TImage (страница Ad-

ditional  палитры компонентов), предназначенный для визуализации изобра-
жений в виде битовой карты (TBitmap), метафайла (TMetafile) или ‘иконки’ 
(TIcon); JPEG-изображения могут быть обработаны с помощью специального 
(дополнительного) компонента Delphi/C++Builder. 
Загрузка файла изображения в Image1 осуществляется соответствующими 

компонентными функциями (дополнительно используются компоненты 
OpenPictureDialog и SavePictureDialog): 

 
if (OpenPictureDialog1->Execute()) 
 Image1->Picture->LoadFromFile(“имя_файла”); 
 
сохранение 
 
if (SavePictureDialog1->Execute()) 
 Image1->Picture->SaveToFile(“имя_файла”); 
 
Размер (в пикселах) области визуализации (полотна) определяется как 
 
int nX=Image1->Width; 
int nY=Image1->Height; 
 
Размер загруженного в Image изображения: 
 
int pX=Image1->Picture->Width; 
int pY=Image1->Picture->Height; 
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В  целях визуализации изображения при его размерах, значительно превы-
шающих размеры окна, компонент Image помещен в контейнер ScrollBox 
(причем свойство Align последнего установлено в alClient); этим достигается 
скроллинг окна показа изображения относительно окна программы. 
Режим масштабирования (с показом загруженного изображения во весь 

размер полотна) включается переводом булева свойства полотна в true (соот-
ветственно и обратное действие): 

 
Image1->Stretch = ! (Image1->Stretch);   
 
Однако при этом (если отношение горизонтального и вертикального раз-

меров изображения не совпадает с таковым полотна) изображение будет ис-
кажено (исказятся пропорции). Для сохранения пропорций (заметим, что 
большинство современных дисплеев используют ‘квадратные’ пикселы, т.е. 
AspectRatio=1) необходимо соответствующим образом изменять размер по-
лотна; в модуле Main.cpp (проект View.bpr) описаны функции MakeScale 
(масштабировать с сохранением пропорций, выполняется при загрузке файла 
изображения) и ClearScale (вернуть режим визуализации без масштабирова-
ния). Соответственно функция MakeScale должны быть вызвана всякий раз 
при изменении размеров окна программы визуализации (реакция на событие 
OnResize), рис.1.1. 

 

 
 
Рисунок 1.1 — Вид окна программы View.exe визуализации файлов изображений
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Для работы с аудиовидеофайлами в системе Delphi/C++Builder использует-
ся компонент MediaPlayer (‘проигрыватель’), представляющий интерфейс к 
мультимедийным возможностям Windows посредством MCI (Media Control 
Interface) - совместимых драйверов; причем большинство методов компонен-
та MediaPlayer реализованы как вызовы стандартной функции  mciSendCom-
mand с соответствующими параметрами [3]. MediaPlayer может управлять 
приводами CD-ROM, MIDI-секвенсорами и рядом других уcтройств. Типы 
обрабатываемых (проигрываемых) файлов – MID, RMI, WAV, MP3, AVI, 
MPG (MPEG-1 поддерживаются в штатной инсталляции Windows, MPEG-2 – 
нет). 
Проигрыватель визуализируется в виде линейки управления (набор кно-

пок, часть или все из которых могут быть сделаны невидимыми путем на-
стройки свойства VisibleButtons в ObjectInspector’е или во время RunTime), 
см. рис.1.2. 

 

 
 
Рисунок 2.1 — Вид окна программы Play.exe проигрывания аудиовидеофайлов  
 
Стандартная загрузка аудиовидеофайла для обработки компонентом Me-

diaPlayer осуществляется следующимм образом: 
… 
MediaPlayer1->Close(); // сначала закрыть проигрыватель 
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if (OpenDialog1->Execute()) 
  { 
   MediaPlayer1->FileName = OpenDialog1->FileName; 
   MediaPlayer1->Open(); // открыть проигрыватель 
  } 
 
Начать проигрывание можно нажатием левой кнопки линейки управления 

(или вызовом MediaPlayer1 →Play() при RunTime); при установке свойства 
AutoOpen в true проигрывание начинается сразу (нажатия кнопки или вызова 
метода Play не требуется). В случае DeviceType = dtAutoSelect проигрыватель 
самостоятельно определит тип устройства по расширению загруженного для 
проигрывания файла. При RunTime - управлении проигрывателем использу-
ются компонентные методы Play,  Pause, Stop, Next, Prev, Step, StartRecording 
и  Eject, соответствующие (слева направо) кнопкам линейки управления. 
Область показа видео задается присвоением свойству Display проигрыва-

теля имени компонента, в область которого осуществляется вывод видео: 
 
MediaPlayer1->Display = Panel1; // показывать на Panel1 
 
Имеется возможность явного определения размера области вывода видео 

(что важно, например, для реализации режима показа в полноэкранном ре-
жиме): 

 
MediaPlayer1->DisplayRect = Rect(2,2,  
            Panel1->Width-1,Panel1->Height-1); // задать размеры видеоэкрана 
 
Большинство из описанных возможной реализовано в тексте файла 

Main.cpp проекта Play.bpr; о дополнительных возможностях проигрывателя 
MediaPlayer см. [2,5], систему контекстной помощи Delphi/C++Builder и др. 

    
1.3 Необходимое оборудование – IBM PC-совместимая ЭВМ, предустанов-

ленная ОС Windows, пакет C++Builder версии выше 4; заготовки проектов 
View.bpr и Play.bpr (могут быть получены как 
http://pilger.mgapi.ru/metods/mm_src.zip). 

 
1.4 Порядок проведения работы. Студент знакомится с  общими сведения-

ми по практике программирования визуализаторов файлов изображений и 
видео (уровень усвоения проверяется с использованием вопросов для само-
проверки), рассматривает заготовки проектов, добивается корректного функ-
ционирования программы, по требованию преподавателя выполняет расши-
ряющую возможности программы модификацию конкретные задания. 
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Возможные задания по модификации программ: 
 

• Расширить функциональность программы просмотра файлов изображений 
возможностью задания произвольного масштаба (согласно линейке 500, 
300, 200, 100, 75, 50, 25, 10% относительно размера изображения в файле). 

• Создать проигрыватель двух мультимедиа-файлов одновременно, исполь-
зующий один комплект кнопок управления. 

• Снабдить проигрыватель шкалой управления, отражающей текущее поло-
жение в проигрываемом файле и имеющей возможность управлять пози-
цией проигрывания. 

• Реализовать возможность убыстренного и замедленного проигрывания 
мультимедиа-файла (линейка 2, 1.5, 1.0, 0.75, 0.5 относительно единичной 
скорости). 
 
1.5 Оформление отчета по работе. Содержимое отчета должно отражать 

результаты самостоятельной работы над проектом (особенности предлагае-
мой  программной реализации и предложения по расширению функциональ-
ности), по требованию преподавателя приводятся твердые копии (распечат-
ки) внешнего вида интерфейса пользователя и выдачи программ. Фиксация 
имеющихся в заготовках проекта ошибок и (особенно) возможностей опти-
мизации кода весьма приветствуются. 

 
1.6 Вопросы для самопроверки. 
 

• Какие высокоуровневые компоненты Delphi/С++Builder применяются в 
программах мультимедиа и какова их функциональность? 

• По каким причинам компонент типа TImage в стандартной поставке не 
может быть использован при работе с изображениями в формате JPEG? 

• Чем отличается масштабирование с сохранением пропорций изображения 
от использования свойства Stretch? Каким приемом достигается скролли-
рование изображения большого размера? 

• Каким путем возможно достичь неизменности режима вписывания изо-
бражения в окно при изменении (вплоть до ‘растягивания’ во весь экран 
дисплея) размеров окна программы? 

• Какими программными средствами может быть реализован показ видео-
файлов во весь экран дисплея? 
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2 Лабораторная работа 2. Принципы создания ПО для  
обработки изображений 

 
2.1 Цель работы – приобретение практических навыков в создании ПО для 

обработки изображений в виде двумерной растровой однослойной графики с 
использованием систем быстрой разработки приложений Delphi и C++Builder 
фирмы Borland Int. 

 
2.2 Теоретические основы.. При наличии в составе языка программирова-

ния средств доступа к информации о каждом  пикселе (обычно интенсив-
ность каждой из трех составляющих цвета)  не представляет труда реализо-
вать практически любую обработку видеоизображения. Несмотря на это, раз-
работка профессиональных приложений (уровня PhotoShop, www.adobe.com,  
PaintShop, www.jasc.com и т.п.), включающих сотни самых разнообразных ви-
деоэффектов, тем не менее требует серьезной работы коллектива программи-
стов. Т.к. необходимо последовательно проводить преобразования многих 
тысяч пикселов, для достижения приемлемой производительности часть про-
граммного кода создается с использованием ассемблера. Заметим, что зачас-
тую при пиксельных преобразованиях конечный результат получается неза-
висимо от других; это позволяет эффективно распараллеливать процесс вы-
числений. 
Приведенными ниже примерами иллюстрированы простые возможности 

изменения изображений, при этом функции компрессии/декомпрессии, изме-
нения палитры и др. выполняются с помощью штатных средств компонент 
сред быстрой разработки приложений. Профессиональные пакеты работы с 
графикой поддерживают слои (совмещенные по координатам независимые 
изображения, причем обычно часть слоя в фоновом цвете  считается про-
зрачной), при этом допускается обработка каждого слоя как независимо, так 
и  совместно с другими. Ниже рассматривается работа с растровой графикой; 
векторная графика (типичный представитель – пакет CorelDraw, 
www.adobe.com) в целом проще и полученные с ее помощью изображения 
легко конвертируются в растр (обратное утверждение неверно).  
Доступ к контексту дисплея в GDI (Graphic Device Interface)  Windows API 

реализуется посредством свойства Canvas (полотно) компонента TImage. Для 
копирования цвета (32-х битовое целое в Windows) из пиксела iX,iY (правая 
нижняя декартова система координат) в переменную iColor применяется сле-
дующий код (аналогично происходит обратное копирование): 

 
long int iColor; // код цвета (32 бита) 
… 
iColor=Image1->Canvas->Pixels[iX][iY]; 
 
Размер (в пикселах) области визуализации определяется как: 
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int nX=Image1->Width; 
int nY=Image1->Height; 
 
Размер загруженного в Image изображения: 
 
int pX=Image1->Picture->Width; 
int pY=Image1->Picture->Height; 
 
Типовой прием изменения цвета  массива пикселов заключается в органи-

зации циклов по координатам: 
 
for (int iX=100; iX<=300; iX++) // цикл по оси абсцисс  
 for (int iY=200; iY<=400; iY++) // цикл по оси ординат  
   if (Image1->Canvas->Pixels[iX][iY]==clRed) // если цвет пиксела красный...  
    Image1->Canvas->Pixels[iX][iY]=clBlue; // cделать его синим! 
 
Заметим, что приведенный выше код недостаточно эффективен по скоро-

сти выполнения (реально  вызываются Windows API функции GetPixel и Set-
Pixel, выполняющиеся достаточно медленно) и область его применения огра-
ничена несложными демонстрационными примерами; профессиональный 
подход заключается в реализации соответствующего кода на ассемблере (с 
последующей ручной оптимизацией,  использовании инструкций MMX и 
SSE [2]) и работе с расположенной в оперативной памяти (ОП) копией мас-
сива пикселов (изображение при этом визуализируется только после полной 
его обработки). Эффективные решения могут быть достигнуты при исполь-
зовании возможностей разработанной Microsoft Corp. библиотеки DirectX 
(примеры C-программирования с использованием  компонентов DirectDraw, 
DirectSound, DirectMusic, DirectInput и DirectPlay этой библиотеки приведены 
в [1,3]). 
При работе на Delphi/C++Builder’е более профессиональным является соз-

дание внеэкранного битового образа (часто с помощью компонента типа 
TBitmap, в дальнейших примерах используется TImage), обработка его в ОП 
и 'сброс' оного на экран (режим копирования CopyMode=cmSrcCopy) с по-
мощью метода Draw [3]. Ниже приведен один из (примитивных) примеров 
использования внеэкранного образа (объект tmpImage): 

 
TImage *tmpImage; // описание объекта tmpImage 
… 
Image1->Picture->LoadFromFile(“имя_файла”); // загрузить и показать  
                                                                              // изображение из файла 
tmpImage = new TImage(this); // создать экземпляра объекта TImage 
tmpImage->Picture = Image1->Picture; // скопировать содержимое Image  
                                                               // во внеэкранный контейнер tmpImage 
for (int iX=100; iX<=300;iX++) // цикл по оси абсцисс  
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 for (int iY=200; iY<=400; iY++) // цикл по оси ординат  
   if (tmpImage->Canvas->Pixels[iX][iY] == clRed) // если цвет пиксела во  
                                                                     // внеэкранном контейнере красный...  
    Image1->Canvas->Pixels[iX][iY]=clBlue; // то выдать его на экран синим! 
… 
delete tmpImage; // уничтожить tmpImage 
 
Перо (Pen) предназначено для отрисовки одномерных графических объек-

тов (линий) и  определяется толщиной (Width), цветом (Color) и стилем 
(Style): 

 
Canvas->Pen->Width = 1; // толщина в 1 пиксел 
Canvas->Pen->Color = clRed; // цвет - красный 
Canvas->Pen->Style = psDashDot; // штрих-пунктир 
 
Кисть (Brush) предназначено для отрисовки двумерных графических объ-

ектов и определяется цветом (Color) и стилем (Style): 
 
Canvas->Brush->Color = clGreen; // цвет - зеленый 
Canvas->Brush->Style = bsDiagCross; // ‘заливка’ – диагональная решетка 
 
Например процедура отрисовки эллипса (в полный размер  Image1) черной 

кистью с ‘заливкой’ диагональной решеткой осуществляется так: 
 
void __fastcall TForm1::ButtonClick(TObject *Sender) 
{ 
 Image1->Canvas->Brush->Color=clBlack; 
 Image1->Canvas->Brush->Style=bsDiagCross; 
 Image1->Canvas->Ellipse(0, 0, Image1->Width, Image1->Height); 
} 
 
Методы MoveTo(int X, int Y) и LineTo(int X, int Y) устанавливают текущую 

позицию и отрисовывают прямую (текущим пером) в заданную точку соот-
ветственно: 

 
void __fastcall TForm1::FormMouseDown(TObject *Sender,  
                                      TMouseButton Button, 
                                      TShiftState Shift, int X, int Y) 
{ // при щелчке кнопкой мыши отрисовать линию из точки (0,0) в (X,Y) 
 Image1->Canvas->MoveTo(0, 0); 
 Image1->Canvas->LineTo(X, Y);  
} 
 
Текущая позиция пера определяется функцией PenPos (функция возвраща-

ет структуру  типа TPoint, содержащую пиксельные координаты абсциссы и 
ординаты точки). 
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Метод Draw(int X, int Y, TGraphic* Graphic) отображает графический объ-
ект Graphic в точке с координатами X,Y (левый верхний угол).  Метод Fill-
Rect(TRect &Rect) выполняет заливку прямоугольной области Rect цветом, 
который задан значением свойства Brush →Color. Метод Draw(int X, int Y, 
TGraphic* Graphic) отображает графический объект  Graphic в точке с коор-
динатами X,Y (TRect  представляет собой структуру, содержащую опреде-
ляющие прямоугольную область целочисленные поля Left, Top, Right, Bottom 
в пикселах). 
Метод CopyRect(TRect &Dest, TCanvas* Canvas,  TRect &Source) копирует 

заданную полотном Canvas прямоугольную область Source в прямоугольную 
область Dest текущего полотна; режим копирования может быть предвари-
тельно задан свойством CopyMode (например, DrawForm→Canvas →Copy-
Mode=cmPatCopy для копирования с логической операцией XOR при смеше-
нии цветов).  
Копирование всего изображения из Image в Карман (Clipboard) осуществ-

ляется методом Assign (при этом Карман очищается от предыдущего содер-
жимого): 

… 
#include <clipbrd.hpp> // хидер прототипов функций работы с Clipboard 
… 
Clipboard->Assign(Image1->Picture); 
 
Обратное копирование требует проверки типа содержимого Кармана с по-

мощью функции HasFormat (предыдущее содержимое Image затирается): 
 
if (Clipboard()->HasFormat(CF_BITMAP)) // если в Кармане именно Bitmap… 
  Image1->Picture->Assign(Clipboard()); 
 
Операция взятия изображения в Карман дополнительно требует очищения 

исходного изображения (при этом в качестве  цвета заполнения  обычно бе-
рется clWindow - фоновый  цвет Windows): 

 
void __fastcall TFormMain::CutToClipboard(TObject *Sender) 
{ // взять все изображение в Clipboard 
 Clipboard()->Assign(Image1->Picture); 
 TRect r = Rect(0, 0, Image1->Width, Image1->Height); 
 Image1->Canvas->Brush->Color = clWindow; // цвет заливки 
 Image1->Canvas->FillRect(r); // залить весь Image1 выбранным цветом  
} 
 
Работа с Карманом с (прямоугольным) фрагментом  изображения осуще-

ствляется с использованием функции CopyRect (режим копирования задается 
переменной CopyMode; возможные значения: cmSrcCopy – копирование с 
замещением исходного изображения, cmWhiteness - предварительное за-
полнение области копирования белым цветом, cmSrcAnd  - копирование с 
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комбинацией имеющегося и наложенного изображения с логическим AND и 
др.). 
Копировать часть изображения в Карман удобно с помощью внеэкранного 

контейнера (необходимое условие применения нижеприведенной функции 
суть xLeft<xRight && yTop<yBottom, в противном случае необходима пере-
становка координат – см. функцию ShiftRectCoord в модуле Main.cpp про-
граммы Paint; структура типа TRect представляет описывающие прямоуголь-
ник координаты {xLeft, yTop, xRight, yBottom}): 

 
void __fastcall TForm1::CopyRectToClipboard(int xLeft, int yTop,  
                                                                           int xRight, int yBottom) 
{ // копировать прямоугольную часть исходного изображения 
  // с левым верхним углом (xLeft,yTop) и правым нижним (xRight,tBottom) 
 TRect rs, rd; 
 TImage *tmpImage;   
 tmpImage = new TImage(this); // создать экземпляр объекта TImage 
 rs = Rect(xLeft,yTop, xRight,yBottom); // область копирования в Image1 
 rd = Rect(0,0, xRight - xLeft,yBottom - yTop); // область копирования в tmpImage 
 tmpImage->BoundsRect = rd; // настройка размеров tmpImage 
 // tmpImage->Width  = xRight  - xLeft;  // та же самая настойка (ширина) 
 // tmpImage->Height = yBottom - yTop; // … высота 
 tmpImage->Canvas->CopyRect(rd,Image1->Canvas,rs); // копировать в tmpImage 
 Clipboard()->Assign(tmpImage->Picture); // копировать из tmpImage в Clipboard 
 delete tmpImage; // уничтожить tmpImage 
} 
 
Частой процедурой перед применением преобразований к части изображе-

ния (копированием  в Карман, деформации, цветокоррекцией и др.) является 
выделение   (прямоугольной) части изображения  ‘резиновой рамкой’, пере-
мещаемой по экрану при манипуляциях мышью. Проблемой при этом явля-
ется необходимость восстановления (после каждого перемещения мыши) 
части изображения, ‘испорченного’ перемещающейся рамкой. Стандартным 
приемом является копирование прямоугольного участка изображения перед  
каждым перемещением правого нижнего угла рамки (левый верхний считает-
ся зафиксированным щелчком кнопки мыши) во внеэкранный образ и вос-
становление этой части изображения после смещения рамки. 
В рассматриваемой программе Pain (модуль Main.cpp проекта Paint.bpr):  
 

• функция Image1MouseDown (вызываемая по событию Image1MouseDown – 
‘нажатие кнопки мыши’) запоминает (передаваемые через формальные па-
раметры) координаты левой верхней точки рамки в переменных   InitialX,  
InitialY, создает внеэкранный контейнер tmpImage и копирует в него изо-
бражение,  

• функция  Image1MouseMove (событие Image1MouseMove – ‘перемещение 
указателя мыши’) путем вызова отрисовывает ‘резиновую рамку’ и осуще-
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ствляет необходимые действия по восстановлению изображения при изме-
нении размеров рамки (тело функции Image1MouseMove выполняется 
только при постоянно нажатой левой кнопки мыши), 

• функция Image1MouseUp (событие Image1MouseUp – ‘отпускание  кнопки 
указателя мыши’) осуществляет финальные действия по отрисовке и унич-
тожению внеэкранного контейнера tmpImage. 

 
Заметим, что эффективнее было бы каждый раз при перемещении указате-

ля мыши копировать во внеэкранный контейнер не все изображение, а лишь 
закрываемую ‘резиновой рамкой’ часть его (манипуляции со значительными 
объемами информации при работе с большими изображениями зачастую вы-
зывают неприятное ‘мерцание’ экрана).  
Именно операции копирования и восстановления части экрана являются 

основой эффектов перемещения частей изображения по экрану в нужное ме-
сто и мультипликации (из внеэкранных контейнеров последовательно копи-
руются в нужное место экрана соответствующие изображения). Профессио-
нальные графические редакторы поддерживают возможность выделения час-
ти изображения произвольной формы (режим ‘лассо’) и соответствующие 
операции с Карманом; реально, конечно, копируется прямоугольный уча-
сток изображения, а находящиеся вне выделяющей нужную область замкну-
той  кривой (описываемой последовательностями прямых или сплайном) 
объявляются ‘прозрачными’ (transparent) и не участвуют в операциях. Режим 
‘волшебной палочки’ (magic wand) позволяет ‘автоматически’ выделить (для 
дальнейшей обработки – копирования, переноса и др.) область изображения 
(при этом используется анализ на принадлежность к заданному диапазону 
цветов или интенсивностей прилежащих к выбранной точке пикселов изо-
бражения). 
Важной операцией обработки изображений (понижение резкости или, на-

оборот, оконтуривание и др.) осуществляется с помощью фильтров. Фильтр 
определяется (обычно квадратной) матрицей коэффициентов преобразования 
kij (i=1 ÷ iN, j=1 ÷ jN, iN и jN - нечетные) и постоянными DivisionFactor и Bias. 
При преобразовании текущей точки (i,j) изображения интенсивности ее цвета 
умножаются на значения kij, полученные значения складываются, делятся на 
DivisionFactor, к полученной сумме прибавляется Bias (считается, что обра-
батываемая точка изображения совпадает с центральным элементом матри-
цы): 

 

color_ij= ck ij
iNi

1i

jNj

1j
ijctorDivisionFa

1Bias ∑ ∑
=

=

=

=
+ , 

 
где color_ij – определяемое значение интенсивности цвета в точке ij, 
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kij – коэффициенты фильтра,  
cij – интенсивность цвета в точках исходного изображения. 

 
Например, при использовании фильтра с iN=jN=5 обрабатываемая (ij-тая) 

точка изображения совпадает c k33 (при этом точка изображения i-3, j-3 про-
ецируется на k11, точка изображения i+3, j+3 проецируется на k55 и т.д.). Та-
ким образом преобразование для каждой точки исходного изображения 
арифметически сводится приблизительно к N2 (N – размер матрицы фильтра) 
операций целочисленного умножения и сложения; при значительном разре-
шении изображения   необходимо использовать ассемблер и функции MMX 
и/или SSE [3].  
При реализации подобных операций с использованием языков высокого 

уровня значительную часть времени отнимает считывание значений интен-
сивности цвета исходного изображения в cij (i=1 ÷ iN, j=1 ÷ jN) и запись рас-
считанного color_ij в образ модифицированного изображения; при этом целе-
сообразно работать не с (визуализирующим изображение) объектом Image, а 
с внеэкранным контейнером (для визуального контроля изменения изобра-
жения полезно регулярно копировать порции обработанного изображения в 
Image). В предлагаемом ПО (файл Paint.exe) изображение загружается в  Im-
age и копируется во внеэкранный образ fltImage, оттуда же копируются эле-
менты матрицы  cij, после описанного преобразования значение интенсивно-
сти цвета color_ij записывается непосредственно в Image (в дисплейное окно) 
- см. процедуру ApplyFilter в модуле Main.cpp (проект Paint.bpr). 

 

 
 
Рисунок 2.1 — Вид окна определения параметров фильтра в программе 

Paint.exe 
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Вид окна определения коэффициентов матрицы фильтрации программы 

Paint.exe приведен на рис.2.1 (доступ к окну осуществляется посредством 
выбора варианта Фильтр… главного меню).  
Находящееся в левом нижнем углу окна поле ввода дает возможность ус-

тановить равные значения всех коэффициентов матрицы (с целью минимиза-
ции дальнейшей настройки),  кнопка ‘Вычислить’ позволяет определить зна-
чение DivisionFactor как сумму значений всех элементов матрицы фильтра. 
Выбранный фильтр применяется ко всем трем составляющим цвета (пред-
варительно можно конвертировать изображение в серый тон посредством 
Edit →Преобразование цвета→В оттенки серого и, если необходимо, сохранить 
преобразованный таким образом файл). 
Типовые значения коэффициентов матрицы фильтра приведены в табл.2.1 

(для упрощения рассматривается матрица 5×5 или даже 3×3). Простейшим 
фильтром является Blur (снижение резкости, размывание изображения); в 

этом случае kij ≡ 1 (i,j=1 ÷ n), ∑
==

==
=

njn,i

1j1,i
ijkctorDivisionFa  и Bias=0 (здесь n – раз-

мер матрицы, kij – значения коэффициентов матрицы). Из общих соображе-

ний ясно, что при ∑
==

==
<

nj,ni

1j,1i
ijkctorDivisionFa  совместно с размытием происхо-

дит потемнение изображения (в противном случае – осветление); аналогично 
Bias>0 приводит к осветлению, а Bias<0 – к потемнению. В графическом ре-
дакторе PaintShop версии 8 создание нового фильтра возможно через Ef-
fects|User Defined…(для версии 4 - Image →User Defined Filters…). В версии  8 
редактора PaintShop  интересные эффекты можно получить (логической) 
комбинацией пикселов двух изображений (Image →Arithmetic… в версии 8); 
необычные (не все из них представимы матрицей) эффекты доступны по-
средством Effects →Artistic Effects. 
С точки зрения программиста важно, что в описываемом случае параметры 

цвета каждого пиксела зависят от цветов окружающих и от цвета исходного; 
при этом применение внеэкранного контейнера изображения неизбежно (ин-
тенсивности пикселов считываются из помещенной во внеэкранный контей-
нер копии изображения, преобразуются и записываются на полотно экрана);  
образец  исходного кода для работы с внеэкранным контейнером см. ниже – 
фрагмент функции ChangeColorAndIntensity.  
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Таблица 2.1. — Типовые матрицы фильтрации изображений. 
 

Матрица 
фильтра 

Division 
Factor, Bias 

Область 
применения 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

11211
12221
22822
12221
11211

 

 

44,0 Снижение резкости (размывание, Blur-
эффект). 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

11111
11111
11111
11111
11111

 

 

25, 0 Более сильное размывание (Blur More) 
 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

14641
41624164
62436246
41624164
14641

 

 

256,0 

‘Размывание’ по Гауссу 
(Gaussian Blur). Фильтр хорошо под-
ходит для ‘размытия’ сюжетно незна-
чимых фрагментов изображений (фо-
тографий) 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

−

−−

−−−−−
−−

−−−
−−

−−−

12121
21212
12521

21212
12121

 

 

-7,0 Эффект двойного изображения (Dou-
ble Vision) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−−−
−−
−−−

111
181
111

 

 

1,0 

Простейший фильтр поиска границ 
(Find Edges); значение центральной 
точки равно сумме остальных с обрат-
ным знаком. 
 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−−−
−−
−−−

111
191
111

 

 

1,256 Выделение контуров (Trace Contour) 
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⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡ −−−

111
000
111

 

 

1,0 Выделение горизонтальных границ 
(Find Horizontal Edges) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−
−
−

101
101
101

 

 

1,0 Выделение горизонтальных границ 
(Find Vertical Edges) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−100
010
000

 

 

1,0 Вариант фильтра поиска границ – гра-
вировка (Emboss 1) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−
−

100
010
002

 

 

1,0 Второй вариант фильтра поиска гра-
ниц – гравировка (Emboss 2) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−
−−

−

010
1101

010
 

 

6,0 Повышение резкости (Sharpen) 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

−−−−−
−−−−−
−−−−
−−−−−
−−−−−

11111
12221
126421
12221
11111

 

 

32,0 Дополнительное повышение резкости 
(Sharpen More) 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

90309
00000
30103
90000
90309

 

 

49,0 Эффект вибрации (Vibrate) 
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⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡
−

111
171
111

 

 

 
1,0 

‘Засаленность, замасливаемость’ 
(Grease) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−−−
−−
−−−

111
171
111

 

 

 
1,165 

‘Сумерки’ (эффектно применение к 
однотонным изображениям или к вы-
бранному цвету) 

 

⎥
⎥
⎥
⎥
⎥

⎦

⎤

⎢
⎢
⎢
⎢
⎢

⎣

⎡

−

−−−−−
−−−−−
−−−
−−−−−
−−−−−

11111
12221
123421
12221
11111

 

 

 
 

1,128 

Имитация грубого рисунка цветными 
карандашами (модифицированный 
Sharpen) 

 

⎥
⎥

⎦

⎤

⎢
⎢

⎣

⎡

−−

−−

311
251
311

 

 

1,0 ‘Психоделический’ фильтр 

 
Часто применяемым эффектом является изменение интенсивностей каждо-

го из цветов текущего пиксела. Т.к. при этом цвет каждого пиксела не зави-
сит от окружающих, внеэкранный контейнер, вообще говоря, не нужен (его 
применение оправдано лишь надеждой увеличения производительности и 
возможностью реализовать ‘откат’ изменений путем простого присваивания 
Image1 →Picture= colImage→Picture;). 
На рис.2.2 приведен вид типовых зависимостей (копии графиков, получен-

ных путем выбора   Изображение→Настройка→Кривые… из главного меню  
PaintShop) интенсивности пикселов преобразованного цвета от интенсивно-
сти исходного; из общих соображений ясно, что ни величина аргумента, ни 
значение функции не должно выходить за границы 0 ÷ 255. В табл.2.2 приве-
дена дополнительная информация: в круглых скобках - определяющие поло-
жение кривых характерные точки (соответствуют рис.2.2), в квадратных – 
полученные методом наименьших квадратов (МНК)  коэффициенты соответ-

ствующих уравнений вида xa i
ni

0i
iy ∑

=

=
=  (x,y – интенcивности  исходной и пре-

образованной цветовых составляющих соответственно). 
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Рисунок 2.2 — Типовые зависимости интенсивности (яркости) преобразованной 
точки изображения (ось ординат) от интенсивности точки исходного изо-
бражений (ось абсцисс) 

 
Таблица 2.2.— Характерные кривые преобразования  

яркости цветовых точек. 
 
Схема  

yа 
 рис.1 

Характерные точки кривой и  
коэффициенты ai  уравнения,  
аппроксимирующего кривую 

Эффект  
от 

 применения 

а) (0,0), (128,128), (255,255) 
[0.0, 1.0] Нет преобразования 

б) (0,0), (255,128) 
[0.0, 0.5] Линейное снижение яркости 

в) 
(0,0), (128,64), (255,255) 
[0.0, -0.00394, 0.0039370079] 
 

Нелинейное снижение ярко-
сти изображения в области 
низкой яркости совместно с 
повышением контраста в 
области высокой яркости 

г) 
(0,0), (128,192), (255,255) 
[0.0, 2.003937, -0.0039370079] 
 

Нелинейное повышение яр-
кости изображения в облас-
ти низкой яркости с повы-
шением контраста в области 
низкой яркости 

д) 
(0,0), (64,96), (192,159), (255,255) 
[0.0, 2.3491512, -0.015940975,  
0.000041765435] 

Снижение контраста в об-
ласти средней яркости 

е) 
(0,0), (64,40), (192,215), (255,255) 
[0.0, -0.0065828087, 0.011595172, -
0.000030193795] 

Повышение контраста в об-
ласти средней яркости 

 
При работе с цветом согласно кривых преобразования изменяются интен-

сивности каждого из трех компонентов цвета (возможно применение собст-
венной кривой для каждого цвета, что равносильно изменению цветового ба-
ланса).  
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В модуле main.cpp проекта Paint.bpr  изменение цвета осуществляется  
функцией ChangeColorAndIntensity (приведен пример нескольких преобразо-
ваний, определяемых значением управляющей переменной rule): 

 
Int iX,iY; 
short colR, colG, colB, intCol, // 0-255 интенсивность цвета (8 бит) 
         selColor = clRed; 
float A=0.0, B=-0.0039370079, C= 0.0039370079; // кривая в) на рис.2.2 и табл.2 
… 
colImage = new TImage(this); // внеэкранный битовый контейнер 
colImage->Picture = Image1->Picture; // скопировали изображение в colImage 
… 
 
for (iX=0; iX<nX; iX++) // цикл по абсциссам пикселов ИЗОБРАЖЕНИЯ    
 for (iY=0; iY<nY; iY++) // цикл по ординатам  
  { 
   // получить интенсивности цветов из внеэкранного контейнера 
   colR=GetRValue(colImage->Canvas->Pixels[iX][iY]); //  интенсивность цвета R 
   colG=GetGValue(colImage->Canvas->Pixels[iX][iY]); // …цвета G 
   colB=GetBValue(colImage->Canvas->Pixels[iX][iY]);  // …цвета B 
   
switch (rule) // переменная rule определяет режим преобразования цвета 
 { 
  case 1: // преобразовать в оттенки  серого ============================ 
              // среднее арифметическое из интенсивностей всех цветов 
              intCol=(colR+colG+colB)/3;               
              Image1->Canvas->Pixels[iX][iY] = RGB(intCol, intCol, intCol);    
              break; 
  case 2: // преобразовать в заданный цвет selColor ====================== 
              Image1->Canvas->Pixels[iX][iY] = RGB(GetRValue(selColor)*intCol/255, 
                                                                             GetGValue(selColor)*intCol/255, 
                                                                             GetBValue(selColor)*intCol/255); 
              break; 
  case 3: // уменьшить интенсивность всех цветов вдвое ================== 
              Image1->Canvas->Pixels[iX][iY] = RGB(colR/2, colG/2, colB/2);   
              break; 
  case 3: // заданные полиномом преобразования цветов ================= 
             // используем схему Горнера для вычисление полинома y=A+B*x+С*x*x                    
             // где A,B,C – известные коэффициенты полинома, x,y – интенсивности 
             // исходного и преобразованного цветов соответственно 
             colR = A + colR * (B + C * colR); // интенсивность цвета R   
             colG = A + colG * (B + C * colG); // …цвета G 
             colB =  A + colB * (B + C * colB); // …цвета B 
             Image1->Canvas->Pixels[iX][iY] = RGB(colR, colG, colB);   
             break; 
  default: // другие значения rule пока не рассматриваются… ============== 
             break; 
 } // конец CASE 
 
} // конец цикла по пикселам изображения (по iX,iY) 
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… 
delete colImage; // отдали память системе 
 
Как видно из вышеприведенного исходного кода, наиболее трудоемко 

функциональное преобразование интенсивностей цветов; причем на показан-
ном примере функция преобразования (заданная коэффициентами A,B,C  по-
линома) едина для всех трех цветов (но, естественно, может быть и различ-
ной).  
Заметим, что в используемой при проведении работ программе Paint пока-

занные на рис.2.2 и табл.2.2 варианты б) ÷ e) реализуются выбором соответст-
вующего варианта подменю Edit →Преобразование яркости→*.  Повторим, 
что в известном пакете PhotoShop доступ к  (визуальной) настройке кривых 
преобразования возможен через меню Изображение→Настройка→Кривые… 
Фильтрация часто применяется в составе других эффектов обработки изо-

бражения – например, ретуширования (‘размытие’ ограниченно области изо-
бражения, указываемой курсором мыши и многих других). 
При создании текстовых надписей необходимо определить параметры 

фонта (напомним, что полотно Canvas является атрибутом некоторого объек-
та – обычно это объект типа TImage): 

 
Canvas->Font->Name = “MS Serif”; // название фонта 
Canvas->Font->Size = 14; // размер оного 
Canvas->Font->Color = clRed; // цвет символов 
Canvas->Font->Style<<fsItalic<<fsUnderline; // наклонный подчеркнутый 
 
В некоторых случаях используется свойство Pitch, задающее шаг отрисов-

ки символов; при этом fpDefault  задает шаг по умолчанию (соответствую-
щий описанию в свойстве Name), fpVariable – возможность изменения шага, 
fpFixed -  постоянную ширину символов (если символы  выбранного свойст-
вом Name фонта имеют переменную ширину, этот фонт будет заменен бли-
жайшим по начертанию моноширинным фонтом): 

 
Canvas->Font->Pitch = fpDefault; // питч 
 
Для большей гибкости настройки фонтов применяется настройка свойства 

Charset (имеет смысл, если выбранный свойством Name фонт включает не-
сколько наборов символов): 

 
Image1->Canvas->Font->Charset = SYMBOL_CHARSET; // стандартный 
 
В большинстве случае свойства Pitch и Charset не нужны. 
Реально для определения описанных параметров используется компонент 

FontDialog, позволяющий в привычном диалоге выбрать параметры фонта: 
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if (FontDialog1->Execute()) 
 Image1->Canvas->Font = FontDialog1->Font; 
 
Определить высоту и ширину (в пикселах, в целях оценки возможности 

вывода в нужную позицию полотна) текстовой строки можно так: 
 
char str[] = “Нет лучше кафедры ИТ-4”; 
… 
int y = Image1->Canvas->TextHeight(str); 
int x = Image1->Canvas->TextWidth(str); 
 
Соотношение между параметрами Size и Height таково (значение Size при-

нято оценивать в пунктах, причем обычно пункт=дюйм/72 ≈ 0,353 мм): 
 

Font->Size = -Font->Height * 72 / Font->PixelsPerInch; 
Font->Height = -Font.Size * Font->PixelsPerInch / 72; 
 
Отрисовывается (горизонтально слева направо)  строка текста на полотне с 

помощью метода TextOut (x,y – левая верхняя точки прямоугольной рамки, 
мысленно охватывающей текст): 

 
Image1->Canvas->TextOut(x,y, “Это отрисовываемая строка”); 
 
Отрисовка строки с отсечением вне заданной прямоугольной области r 

осуществляется методом TextRect (x,y – аналогично TextOut): 
 
TRect r; 
… 
r.Top = 10; 
r.Left = 10; 
r.Bottom = 100; 
r.Right = 100; 
Image1->Canvas->TextRect(r, 20, 20, "Привет, МГУПИ!"); 
 
Для вывода текста на прозрачный фон обычно используется следующий 

прием: 
 
Canvas->Brush->Style = bsClear; 
 
Для профессиональных пакетов обработки изображения обязательным яв-

ляется наличие эффектов геометрического преобразования (скручивание, 
эффект линзы и т.д.); причем возможно применение этих эффектов как ко 
всему, так и к выделенной части изображения. В общем случае геометриче-
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ские преобразования являются результатом применения заданных функций 
преобразования: 

 

⎪⎩

⎪
⎨
⎧

=
=

ϕ
ϕ

),,(
),,(

yxy
yxx

11y2

11x2  

 
где yx 11,  - исходные координаты пикселов изображения, 

yx 22 ,  - преобразованные координаты,  
ϕϕ y,x  - заданные функции преобразования. 

 
Простейшими преобразованиями являются аффинные, при этом: 
 

⎪⎩

⎪
⎨
⎧

++=
++=

,
,

ayaxay
ayaxax

y1yy1yx2

x1xy1xx2  

 
где aij  - постоянные коэффициенты. 
 
Приведенные зависимости удобны для использования в векторной графи-

ке, применение их для растровой графики затруднено по чисто практическим 
соображениям (т.к. координаты пикселов преобразованного изображения не 
совпадают с таковыми изображения исходного, прямое определение цвета 
преобразованных пикселей невозможно). 
Выходом из положения является определение интенсивности цвета в неко-

торой точке изображения путем  усреднения интенсивностей цветов  точек-
соседей (на исходном изображении). Для   этого используют интерполяцию 
(обычно с применением сплайнов) величины интенсивности каждого из ба-
зовых цветов RGB в окрестности рассматриваемой точки. На рис.2.2 показа-
ны 9 точек i∈[i-1,i,i+1], j∈[j-1,j,j+1], по которым строится интерполяционная по-
верхность интенсивности цвета, и значение интенсивности A=f(x,y) в задан-
ной точке x,y. На рис.2.2 матрица параметров имеет размерность 3×3, но мо-
жет иметь размер и 4×4 и 5×5 и больше. 
Особенно удобно применять эту технологию при масштабировании изо-

бражений (увеличении или уменьшении числа пикселов по горизонтали и 
вертикали, причем коэффициенты масштабирования по горизонтали и верти-
кали необязательно совпадают). При масштабировании изображения прово-
дится преобразование параметров функции X и Y в соответствие с заданны-
ми коэффициентами масштабирования и по значению интерполирующей  
функции в нужной точке определяется  интенсивность  цвета пиксела (для 
каждого цвета RGB независимо). В Windows операции преобразований (и 
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масштабирования в т.ч.) 
реализованы очень кор-
ректно (в состав Win-
dows API включены эф-
фективные функции 
сплайн-интерполяции). 
Печать изображений 

(представляющая  осо-
бую  сложность для Win-
dows-программирования) 
в системах Del-
phi/C++Builder легко 
осуществляется с ис-
пользованием штатно 
входящего в системы 

программирования фирмы Borland Int. набора компонентов QuickReport 
(фирма QuSoft AS  Fred Olsens gt. 1  N-0152 Oslo Norway,  http://www.qusoft.no, 
макет будущей страницы проектируется в визуальном режиме аналогично 
внешнему виду форм, для вывода изображений используется компонент 
QRImage);  выбор принтера осуществляется компонентом PrintDialog, на-
стройка режимов печати - PrinterSetupDialog. 

 
2.3 Необходимое оборудование – IBM PC-совместимая ЭВМ, предустанов-

ленная ОС Windows, пакет C++Builder версии выше 4; заготовка проекта 
Paint.bpr (может быть получена как http://pilger.mgapi.ru/metods/mm_src.zip). 

 
2.4 Порядок проведения работы. Студент знакомится с общими сведения-

ми по практике программирования приложений, направленных на обработку 
файлов изображений (при проверке уровня усвоения целесообразно исполь-
зовать вопросы для самопроверки), анализирует исходные тексты заготовки 
проекта, добивается корректного функционирования программы, по требова-
нию преподавателя выполняет расширяющую возможности программы мо-
дификацию конкретные задания. 
Рекомендуется использовать изображения размерами стандарта не выше 

VGA (640×480 пиксел), причем для лучшего уяснения действия фильтров 
желательно иметь как крупные, так и мелкие детали на изображении. 

 
Возможные задания по модификации программ: 
 

• Расширить функциональность программы возможностью печати текста на 
экране под заданным углом к горизонтали и на заданном цвете фона. 

 
Рисунок 2.2 — Интерполяция функции интенсивно-

сти цвета A(x,y) по 9 точкам (матрица 3×3). 
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• Реализовать дополнительную (заданную преподавателем) функцию преоб-
разования интенсивности (яркости) цветов. 

• Указать последовательность действий (с точки зрения программирования) 
для реализации перемещения части изображения по экранному полотну. 

 
2.5 Оформление отчета по работе. Содержимое отчета должно отражать 

результаты самостоятельной работы над проектом (особенности предлагае-
мой  программной реализации и предложения по расширению функциональ-
ности), по требованию преподавателя приводятся твердые копии (распечат-
ки) внешнего вида интерфейса пользователя и выдачи программ. Фиксация 
имеющихся в заготовках проекта ошибок и возможностей оптимизации кода 
весьма приветствуются. 

 
2.6 Вопросы для самопроверки. 
 

• Что такое внеэкранный битовый образ и почему его применение при опера-
циях модификации цвета и иных преобразованиях повышает быстродейст-
вие программы? 

• Какие пути повышения быстродействия операций модификации изображе-
ний известны? 

• Каким образом реализуется перемещение ‘резиновой нити’ по экрану? 
• В чем суть применения фильтров при модификации изображения? Какими 
свойствами обладают фильтры сглаживания? подчеркивания границ? эф-
фекта гравировки? 

• Какими свойствами должны обладать функции преобразования интенсивно-
сти цвета каждого пиксела? 

• В чем заключается суть технологии сплайн-интерполяции при преобразова-
ниях изображения? 
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3 Лабораторная работа 3. Цифровая запись, редактирование и  
воспроизведения звука 

 
3.1 Цель работы – приобретение практических навыков в получении и 

цифровой обработке звука c использованием стандартного ПО. 
  
3.2 Теоретические основы. Источником представляющих практический 

интерес звуковых колебаний являются микрофон, радио и теле- передачи, 
ресурсы сети InterNet, устройства хранения  (CD, магнитная лента, flash) и 
синтеза звука.  
Звук представляет собой механические колебания физической среды (воз-

духа, скорость распространения около 340 м/сек) частотой приблизительно 
20 ÷ 20000 Гц,  современные системы обработки звука основаны на преобра-
зовании этих колебаний в электрический сигнал, последующей его (аналого-
вой или цифровой) обработки и вывода вновь в виде колебаний физической 
среды. Эффект стереофонии достигается временной разницей колебаний, 
легко улавливаемой благодаря наличию приблизительно 20-сантиметровой 
базы между приемниками аудиоинформации – ушами человека (разница по 
времени 0,2/340 ≈ 6×10-4 сек). 
Преобразование аналогового сигнала в цифровую форму выполняет анало-

го-цифровой преобразователь (АЦП), служащий для дискретизации сигнала 
по времени (частота оцифровки) и квантования по уровню (собственно циф-
ровое представление сигнала). Обычно в АЦП применяется технология пре-
образования с импульсно-кодовой модуляцией (PCM, Pulse Code Modulation). 
Временные промежутки между моментами преобразования сигнала называ-
ют интервалами выборки (Sampling Interval); эта величина обратно пропор-
циональна частоте выборки,  или сэмплингом (Sampling Rate). Амплитуда 
аналогового сигнала (Sample Value) при каждом преобразовании делится 
(квантуется) по уровню и кодируется в соответствующий параллельный 
цифровой код (Digital Sample), время преобразования аналогового сигнала в 
цифровой код именуется временем выборки (Sampling Time), рис. 3.1. Разре-
шающая  способность АЦП - наименьшее значение аналогового сигнала, ко-
торое приводит к изменению цифрового кода. Например, если АЦП выдает 8-
разрядный код, разрешающая способность равна 1/(28)=1/256 от максималь-
ной амплитуды аналогового сигнала (около 0,4% в относительных единицах), 
16-разрядный АЦП имеет точность представления сигнала не хуже 
1/(216)=1/65536 (0,0015%). Увеличение разрядности АЦП приводит к росту  
его динамического диапазона (каждый дополнительный бит соответствует 
увеличению приблизительно на 6 дБ). 8-разрядное преобразование обеспечи-
вает динамический диапазон 48 дБ (качество кассетного магнитофона), 12-
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разрядное – 72 дБ (качественный катушечный магнитофон), 16-разрядное – 
96 дБ (качество аудио компакт-диска). 

 
Рисунок 3.1 — Характеристики процесса преобразования между аналоговым и 

цифровым сигналами 
 
С практической точки зрения качество аудиовоспроизведения определяет-

ся скорость передачи данных (bitrate, битрейт).   Качество, неотличимое 
большинством рядовых слушателей от качества CD, достигается при скоро-
сти передачи  112 ÷ 128 Кбайт в секунду; при этом коэффициент MPEG-
сжатия достигает 14:1 относительно исходного объема. Специалисты обычно  
требуют скорости передачи 256 ÷ 320 Кбайт/сек (это легко достижимо для 
CD-проигрывателя, но для многих отечественных InterNet -линий недоступ-
но). 
При цифровой обработке звуковой информации на ЭВМ преобразованию 

подвергается именно цифровое (а не аналоговое) представление сигнала. В 
данной работе используются формат аудиоинформации WAV (метаформат, 
при котором способ  кодирования аудиосигнала может быть любым – напр., 
PCM без сжатия) и сильно компрессированный формат MP3 (MPEG-Audio 
Layer-3, алгоритм сжатия учитывает психоакустическую модель слуха чело-
века). 
При выполнении работы используется программа Nero Wave Editor  из 

комплекта Ahead Nero (фирма Ahead Software AG, http://www.nero.com), обла-
дающей значительными возможностями по редактированию и преобразова-
нию аудиформатов при удобном пользовательском интерфейсе. В цифровом 
канале легко достигаются многие аудиоэффекты, труднодостижимые при 
аналоговой обработке;  напр., реверберация (эффект многократного эха), по-
давление акустической завязки выхода усилителя звуковой частоты на его 
вход (методом снижения  звукового уровня в определенном частотном диа-
пазоне) и др. 
Большую часть главного окна интерфейса программы  занимает область 

графического представления амплитуды звукового сигнала от времени (ам-



                                                                                   

- 30 - 

плитудная характеристика, АХ), в центре нижней части представлены окна 
мгновенной амплитудно-частотной характеристики (АЧХ) сигнала (для каж-
дого стереоканала отдельно), рис. 3.2. Управление программой стандартное – 
через главное меню и ‘горячие’ кнопки в верхней части главного окна. Через 
вариант главного меню Edit доступны функции  копирования всего или части 
(выбор нужного фрагмента осуществляется проведением мыши с нажатой 
левой кнопкой вдоль графика АХ) аудиофайла  и конвертации его формата, 
вариант View позволяет управлять формой изображения (напр., вместо  гра-
фика АХ - Wave Display могут быть выбраны Spectrogram Display или Wavelet 
Display). Nero Wave Editor дает возможность также осуществлять запись ау-
диоклипов (Audio →Record). 

 

 
 
Рисунок 3.2 — Главное окно пользовательского интерфейса программы Nero 

Wave. 
 
Указанный потенциал программы Nero Wave Editor  дает возможность 

гибкого редактирования аудиофайлов: 
 

• Изменения темпа (скорости) воспроизведения (Tools →Time Correction). 
• Заданного изменения огибающей уровня звука (Volume →FadeIn,  Vol-

ume →FadeOut). 
• Редактирования АЧХ аудиоклипа (Tools →Equaliser, Transpose, Dynamic 

Processor). 
• Внесения стандартных эффектов в звучание (Effects →Delay, Flanger, Chorus, 

Reverb). 
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• Тонкое регулирование качества звука и применение шумоподавления (En-
hancement →High Frequence Correction, Noise Reduction). 

 
3.3 Необходимое оборудование – IBM PC-совместимая ЭВМ с комплектом 

аудиоаппаратуры (микрофон, устройства аудио воспроизведения – желатель-
но наличие высококачественных наушников), предустановленные ОС Win-
dows и программа Nero Wave Editor.  

 
3.4 Порядок проведения работы. Студент знакомится с практикой получе-

ния аудиофайлов различными методами (включая оцифровку записи с линии 
и/или микрофона), производит заданное преподавателем редактирование 
файлов (задаваемое обычно субъективными выражениями) и проверяет (пу-
тем индивидуального прослушивания через наушники) наличие и качество 
полученного аудиоэффекта. 
Типовые задания на редактирование аудиоданных: 
 

• Изменение воспроизведения темпа аудиоклипа (получение ‘голоса Бурати-
но’ или ‘утрированного баса’). Провести подобные преобразования мето-
дом Tools →Transpose (использовать настройки ‘Helium Speech’ и ‘Monster 
Speech’). 

• Установка АЧХ аудиоклипа методом использования эквалайзера 
(Tools →Equalizer). При работе учесть, что регулировка ширины полосы ка-
ждого из 6 каналов эквалайзера осуществляется регуляторами Bandwidths 
(в октавах) в окне Equalizer. 

• Настройка динамических свойств воспроизведения (зависимость выходно-
го уровня сигнала от уровня входного, Tools →Dynamic Processor). 

• Добавление эффекта однократного эха (Tools →Delay), ‘дрожания’ 
(Tools →Flanger), хорового исполнения (Tools →Chorus), реверберации 
(Tools →Reverb). 

• Понижение уровня шумов аудиоклипа (Enhancement →Noise Reduction). 
 
3.5 Оформление отчета по работе. Отчет должно содержать технические 

параметры компонентов аудиосистемы и обработанных аудиофайлов (вклю-
чая частоту семплинга, разрядность оцифровки, используемый битрейт), опи-
сание произведенных действий по редактированию файлов и полученного 
эффекта. 
Полученные в результате обработки аудиофайлы предъявляются для про-

слушивания и оценки выполненной работы. 
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3.6 Вопросы для самопроверки. 
 

• Назвать источники звуковой информации (в порядке личного мнения по 
снижению распространенности). 

• Что представляет собой звук? Каков диапазон частот, воспринимаемых че-
ловеческим ухом? Какова природа стереоэффекта? 

• Что такое амплитудная (АХ) и амплитудно-частотная характеристики 
(АЧХ), в каких координатах они строятся? 

• Какие параметры оцифровки звука применяются? Что такое ‘битрейт’ и ка-
кому качеству звучания соответствуют стандартные величины битрейта? 

• Что такое эффект реверберации и каким образом он может быть достигнут? 
• Что такое ‘звуковая завязка’ и каковы возможные пути борьбы с ней? 
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4 Лабораторная работа 4. Получение и цифровая обработка  
фотоизображений 

 
4.1 Цель работы – приобретение практических навыков в получении фо-

тоизображений и их цифровой обработке c использованием стандартного 
ПО. 

 
4.2 Теоретические основы. Источником цифровых изображений являются 

сканеры, цифровые фотоаппараты и графические редакторы. В настоящее 
время сканеры и цифровые фотоаппараты подключаются к 
ПЭВМ посредством интерфейса USB (http://www.usb.org). USB 
(Universe Serial Bus, 1996 ÷ 2000 г.) является последователь-
ной шиной и обеспечивает пропускную способность 1,5 (LS – 
Low Speed) и 12 Мбит/сек (FS – Full Speed); в версии USB 2.0 определена 
скорость в 480 Мбит/сек (HS – High Speed), причем в одной системе могут 
одновременно работать устройства со всеми тремя скоростями.  
Преимуществами USB является простое подключение до 127 периферий-

ных устройств, возможность коммутации,  подключения/отключения уст-
ройств при работающей системе, поддержка технологии PnP (Plug and Play, 
автоматическое конфигурирование в момент включения/выключения). Ин-
формация по шине USB передается посредством пакетов (специальным обра-
зом организованным цепочками бит).  

USB осуществляет обмен данными между HOST-компьютером и множест-
вом периферийных устройств. Устройства (devices) могут являться хабами, 
функциональными устройствами или их комбинацией.  Устройство-хаб (hub) 
всего лишь обеспечивает дополнительные точки подключения устройств к 
шине, функциональной устройство (function) предоставляет системе допол-
нительные функциональные возможности  (цифровые джойстики, цифровой 
интерфейс с акустическими колонками и др.), комбинированные устройства  
(compound device) представляют хаб с подключенными к нему несколькими 
устройствами.  Работой всей системы управляет хост-контроллер (host con-
troller), представляющий аппаратно-программную подсистему хост-
компьютера.  
Физическая топология USB представляется  многоярусной звездой - вер-

шина – хост-контроллер, к каждому порту которого подключаются перифе-
рийные устройства или промежуточный хаб, причем всего допустимо до 5 
уровней каскадирования (при длине кабеля каждого уровня до 5 м имеем все-
го до 25 м). USB допускает питание устройств током до 0,5 A (в момент под-
ключения – не более 0,1 A) при напряжении 5 В; поддерживается режим уда-
ленного пробуждения (remote wakeup), при котором устройство может подать 
сигнал (находящемуся в приостановленном состоянии) хост-компьютеру с 
целью его активизации. Типы разъемов USB приведены на рис.4.1. 
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Рисунок 4.1 — Гнезда USB: a) – типа ‘A’, б) – типа ‘B’ стандартное,   в,г,д) – ми-
ниатюрные типа ‘B’ 

 
В качестве источника изображений используется цифровая фотокамера 

(ЦФК). Важной характеристикой ЦФК является разрешение (измеряется в 
числе пиксел, составляющих изображение); современные бытовые фотокаме-
ры имеют разрешение до 5 ÷ 7 миллионов пиксел (мегапиксел, Мпкс), профес-
сиональные – до 10 и более. Разрешение определяется параметрами исполь-
зуемой в данном  ЦФК полупроводниковой матрицы, служащей для преобра-
зования воспринимаемого изображения в пикселы (для матриц обычно при-
меняется технология ПЗС – прибор с зарядовой связью). Информация с мат-
рицы считывается и обрабатывается встроенным микропроцессором (МП),  
демонстрируется на расположенном с задней стороны ЦФК миниатюрном 
жидкокристаллическом дисплее и в виде файлов (при необходимости ком-
прессированных стандартными методами – обычно JPG) сохраняется на 
сменном ПЗУ (обычно Flash-карта), для хранения может использоваться ми-
ниатюрный жесткий диск. Обычно видеофайлы в дальнейшем переносятся на 
ПЭВМ для окончательной обработки; в последнее время практикуется пря-
мое подключение ЦФУ к малогабаритным цветным принтерам. 
Вторая важная характеристика – величина оптического (достигающегося 

путем изменения фокусного расстояния объектива) увеличения изображения 
(явление трансфокации, оптический zoom); для хороших моделей величина 
трансфокации достигает 10 ÷ 12. Важно отметить, что при трансфокации чет-
кость изображения практически не снижается (разрешение остается преж-
ним), цифровое же увеличение всегда снижает четкость изображения (т.к. 
снижается составляющее изображение число пикселов). Величина экспозиции 
(определяемая диафрагмой и выдержкой) и наводка на резкость во всех со-
временных ЦФК осуществляются автоматически (режим ) путем ис-
пользования известных алгоритмов встроенного МП,  хотя допускаются 

предпочтения (приоритет выдержки   или диафрагмы ). 
Встроенный МП во время съемки вычисляет и визуализирует гистограмму 

яркости изображения (см. рис. справа ниже); стремиться следует к наиболее 
равномерной гистограмме. 
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На рис. слева ниже показан 
внешний вид одной из лучших 
непрофессиональных ЦФК Power 
Shot S3 IS фирмы Сanon (здесь 3- 
фотовспышка, 4, 5 – правый и 
левый микрофоны,  7 – объектив,  
11 – контейнер для Flash-карты типа SD – Secure Digital, 10 – отсек батарей 
питания (4 шт. типа АА), 13 – розетка разъема USB 2.0, 14 – разъем подклю-

чения внешнего питания; 
имеется разъем коаксиального 
стерео/видео кабеля). 
ЦФК S3 IS имеет разрешение 

6 Мпкс, позволяет получать 
фотоизображения 

максимального  размера 
2816×2112 пикселов (объем ви-
деофайла 2,7 Мбайт при 
наилучшем качестве 

сохранения , т.е. около 370 
кадров на каждый Гбайт Flash-
карты) и видеоизображения 
VGA-формата (640×480 пиксел 
при  30 кадрах/сек , 

видеопоток 2 Мбайт/сек, максимальный размер видеоклипа – до 1 Гбайт или 
до 1 часа непрерывной записи). 
В состав комплекта ЦФК входит специальное ПО для переноса получен-

ных данных на ПЭВМ и 
манипуляций с ними. Однако 
Windows’XP позволяет 
использовать технологию 
‘Мастеров…’ для работы с 
внешними устройствами, при 
этом часто можно обойтись 
без поставляемого совместно 
с ЦФК специализированного 
ПО. ‘Мастер’ автоматически 
отслеживает подключение 
внешнего устройства и 
предлагает возможности 
(ограниченные, обычно 
только перенос данных с ЦФК 
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на ПЭВМ;  см. рис. справа). Окончательную обработку данных следует про-
водить с использованием специализированных растровых графических ре-
дакторов (от простейшего MS Paint до ухищренных уровня Adobe Photoshop). 
В данной работе используется пакет Paint Shop Pro фирмы Jask Software 

(http://www.jasc.com), обладающий не меньшими по сравнению с Adobe Photo-
shop функциональными возможностями и, по мнению автора данной работы, 
более удобным пользовательским интерфейсом (рис. 4.2). 

 

 
 
Рисунок 4.2 – Внешний вид главного окна графического пакета Paint Shop Pro 8. 

 
Для лучшей ориентации в возможностях Paint Shop Pro полезно воспользо-

ваться системой встроенной помощи (управление через главное меню по-
средством Help →  Help Topics, Help →  Contex Help, Help →  Learning Center). 
Стандартные действия коррекции изображений: 
 

• Установка цветового баланса (Enchange Photo →  Automatic Color Balance). 
Цветовой баланс управляется ползунком : вправо – ‘холоднее’ (голубой 
оттенок) и влево – ‘горячее’ (оранжевой оттенок) или прямой установкой 
цветовой температуры (нейтраль соответствует 6000OC – эффективная  
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цветовая температура фотосферы Солнца, точка ‘Лунный свет’ - 6500OC, 
‘Флуоресцентная лампа’ - 4200 OC). 

• Установка контраста (Enchange Photo →  Automatic Contrast Enhancement). 
Контраст задается дискретно – через Bias (см. работу 2  этого руководства), 
Strength (интенсивность) и Appearance (внешнее проявление). 

• Установка насыщенности цвета  (Enchange Photo →  Automatic Saturation 
Enhancement). Насыщенность устанавливается дискретно - через Bias и 
Strength. 

• Установка прозрачности (Enchange Photo →  Clarify). Прозрачность задается 
дискретно (диапазон 1 ÷ 5) через Strenght off effect (интенсивность эффек-
та). 
 
Широкие возможности доступны через вариант Effects главного меню, ва-

риант Effect Browser дает возможность доступа к применению разнообразных 
инструментов редактирования изображений; Effects →  User Defined позволяет 
применить к изображению матрицу фильта, подобную описанной выше в ра-
боте 2. 
Полезной особенностью пакета Paint Shop Pro является возможность запи-

си проведенных действий по редактированию изображений (сценария дейст-
вий) и в дальнейшем неоднократное применение этого сценария (script). 
Имеются также предустановленные сценарии (например, автоматическая 
всесторонняя коррекция изображения, Enchange Photo →  One Step Photo Fix). 
Типовые задания для выполнения студентами: 

 
• Исправить некорректное фотоизображение – повысить контраст, сбаланси-
ровать цвета. 

• Создать изображение в  выбранном гипертрофированном цвете (цветах). 
• Создать из сделанной при дневном свете фотографии художественный  

‘вид в лунную ночь’. 
• Получить художественный ‘эффект раскаленной пустыни’. 
• Из заданной фотографии получить часто используемое в рекламе ‘чекан-
ное’ изображение (Emboss) и ‘оконтуривания’ (Trace Contour). 

• Применить цифровое масштабирование к выбранной части фотоизображе-
ния, проанализировать влияние масштабирования на резкость изображе-
ния. 

• Применить эффекты ‘размытия’ (Dilate, Blur, Soften) и ‘повышения резко-
сти’ (Sharpen). 
 
4.3 Необходимое оборудование – IBM PC-совместимая ЭВМ, оснащенная 

USB-входами и драйверами USB (для Windows’XP установка специализиро-
ванного для конкретного цифрового фотоаппарата ПО необязательна), циф-
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ровая камера с кабелем USB. Для редактирования фотоизображений следует 
установить пакет Paint Shop Pro версии не ниже 8.0. 

 
4.4 Порядок проведения работы. Студент знакомится с общими сведения-

ми по практике получении фотоизображений и их цифровой обработке, под 
руководством преподавателя  производит фотосъемку, подключает фотока-
меру к ПЭВМ, переносит файлы фотоизображений на ПЭВМ и проводит их 
обработку в соответствие с требованиями преподавателя или же собственно 
сформулированными на основе желаемого эффекта или с целью компенсации 
полученных при съемке недостатков (не полностью корректная цветовая 
гамма, яркость, план изображения). 

 
4.5 Оформление отчета по работе. Отчет должно содержать технические 

параметры фотокамеры, кабеля связи и используемой ЭВМ. В процессе пере-
носа файлов изображений и их обработки  фиксируются параметры получен-
ного файла (формат изображения, размер изображения в пикселах,  занимае-
мое файлом место на диске и др.).  
Полученные в результате оцифровки и  редактированные изображения  

предъявляются для просмотра и оценки выполненной работы. 
 

4.6 Вопросы для самопроверки. 
 

• Какими количественными характеристиками определяется цифровое фото-
изображение? 

• Какие интерфейсы обычно используются для передачи файлов изображе-
ний? 

• Что такое цветовая палитра и с какой целью используется это понятие? 
• С какой целью вычисляется гистограмма изображения? Для чего использу-
ется гистограмма яркости? Гистограмма отдельных цветовых составляю-
щих? 

• Что такое ‘цветовой баланс’ изображения? С какой целью введено понятие 
цветовой температуры? 
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5 Лабораторная работа 5.  Получение и цифровая обработка  
видеоданных 

 
5.1 Цель работы – приобретение практических навыков в получении ви-

деоизображений и их цифровой обработке c использованием стандартного 
ПО. 

 
5.2 Теоретические основы. Источником видеоизображений изображений 

являются видеокамеры (включая цифровые фотоаппараты с функцией видео),  
телевизионный сигнал и специализированные программы синтезирования (не 
очень реалистичного в настоящее время) видео. Источник видео в большин-
стве случаев подключаются к ПЭВМ посредством интерфейса IEEE 1394 
(FireWire, iLink, Digital Link, MultiMedia Connection). IEEE 1394 (High Per-
fomance Serial Bus, 1995 г., стандарт основан на используемой в Apple Com-
puter шине FireWire) является последовательной шиной и обеспечивает про-
пускную способность (округленно) 100, 200 и 400 Мбит/сек (планируется 
реализации скоростей 800, 1600 и 3200 Мбит/сек). 
Преимуществами IEEE 1394 является  подключение до 63 периферийных 

устройств без применения дополнительной аппаратуры (хабов),  поддержка 
технологии PnP, свободная топология присоединения устройств (до 27 разъ-
емов разветвления на одном устройстве), питание устройств током до 1,5 A 
при напряжении 8 ÷ 40 В. Длина сегмента кабеля до 4,5 м, суммарная длина – 
до 72 м, между любой парой узлов не может быть более 16 кабельных сег-
ментов; в последующих реализациях предполагается автоматическое исклю-
чение  петель  физической топологии и использование оптоволокна. 
Типы разъемов IEEE 1394 приведены на рис.5.1. 

 
Рисунок 5.1 — Разъемы IEEE 1394: a) – 6-ти контактное гнездо, б) – 4-х контакт-

ное гнездо (только для оконечных устройств) 
 
Распространенным ПО для оцифровки данных с видеокамеры и после-

дующего монтажа видеофильмов является Adobe Premiere (фирма Adobe 
Systems Inc., http://adobe.com), Ulead Media Studio (UleadSystems, http:// 
ulead.com), Pinnacle Studio (Pinnacle Systems, Inc., http://pinnaclesys.com), 
WinDVD Creator (InterVideo, http://intervideo.com) и др. 
Первым этапом является получение видеоданных в виде единого файла на 

жестком диске ПЭВМ. Заметим, что даже при использовании видеокамер с 
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цифровой записью этот этап необходим (ибо формат цифровой записи на ви-
деокамере обычно не совпадает со стандартами видеофайлов в ПЭВМ).  
В табл. 5.1 приведены основные форматы  аудиовидеороликов,  они ис-

пользуют 24-х битовой цвет и (в большинстве случаев) частоту смены кадров 
25 кадров/сек [4]. Следует обратить внимание на необходимость иметь доста-
точно пространства на диске – для качества DVD это около 2,6 Гбайт на 1 час 
видео (440 Mбайт на 10 мин, 44 Mбайт на 1 мин). Конечно, бессмысленно 
оцифровывать сигнал с бытовой аналоговой видеокамеры в стандарте DVD – 
для этого лучше всего подойдет VHS или Video CD. 

 
Таблица 5.1. – Основные стандарты видеоданных.  
 

Видеоданные Аудиоданные Обще-
приня-
тое на-
имено-
вание 

Размер изо-
бражения, 
пиксел 

Формат 
видео- 
 файла 

Поток 
данных, 
kбит/сек 

Формат 
аудио-
файла  

частота 
оцифров-
ки, kHz 

Поток 
данных, 
kбит/сек 

Video 
CD 

352×288 MPEG-1 1 150 MPEG 
стерео 

44,1 224 

VHS 352×288 -.-.- 2 400 -.-.- 44,1 224 
SVCD 480×576 MPEG-2 2 400 -.-.- 44,1 224 
DVD 720×576 -.-.- 6 000 -.-.- 48 224 
Micro 
MV 

720×576 -.-.- 10 000 -.-.- 48 256 

 
Главное окно удобной для создания видео программы Pinnacle Studio 

ver.9.0 приведено на рис.5.2 (стандарт DVD - захват в режиме 720×576 пик-
сел, выходной файл формата MPEG-2).  Действие по преобразованию видео-
данных из представления видеокамеры в формат дискового файла ПЭВМ 
инициируется выбором ‘Захват’ главного меню, параметры захваченного 
файла определяются в меню ‘Настройки’,  во время оцифровки текущее изо-
бражение можно просматривать в окне видеоизображения.  
Для последующего монтажа видеофильма необходимо разбить единый 

файл на сцены (части видеопотока, представляющие собой законченные смы-
словые блоки). Практически всегда это действие является предварительным – 
при монтаже видеофильма сцены будут серьезным образом перекомпонова-
ны в соответствие с художественным представлением режиссера. 
В большинстве современных пакетов для создания видеофильмов реализо-

ван режим автоматического разбиения на сцены (новая сцена начинается в 
момент резкого изменения содержания видеопотока); часто этого вполне 
достаточно. 
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Рисунок 5.2 — Главное окно программы Pinnacle Studio 9.0  в режиме захвата 

информации c видеокамеры в DVD-совместимом режиме. 
 
При ручном выделении сцен (режим ‘Редактирование’ 

 главного меню) появляется воз-
можность предварительного редактирования снятого материала (в основном 
удаления явно неудачных кадров). На рис.5.3 приведена копия главного окна 
программы Pinnacle Studio ver.9.0 в режиме ‘линия времени’ (средняя кнопка 
триады  в правой части главного окна). В этом режиме видео-
данные представлены в виде непрерывной горизонтальной ленты (синхрон-
ная аудиодорожка находится ниже), поддерживаются функции разделения 
видеклипа в заданный момент времени и вырезания определенной таким об-
разом части клипа (правая кнопка мыши). 
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Рисунок 5.3 — Редактирование видеоданных в режиме ‘Линия времени’. 
 
На рис.5.4 приведена копия главного окна в режиме ‘Сценарий’ (левая 

кнопка триады ). Этот режим удобен, напр., для задания пере-
ходов между сценами (выбираются из имеющегося списка, см. левую верх-

нюю часть рис.5.4). Режим ‘Монтажный лист’  удобен при 
создании и редактирования списка видео и аудиоклипов. 

 
 

Рисунок 5.4 — Редактирование видеоданных в режиме ‘Сценарий’. 
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Цифровая обработка видеоданных  включает: 
 

• Изменение цветового фона, контраста, добавление визуальных эффектов 
(при необходимости, с целью коррекции исходно снятого видеоматериала 
или достижения определенных художественных эффектов).  

В Pinnacle Studio определены эффекты времени – изменение скорости, 
стробоскоп,  цветовые видеоэффекты – цветокоррекция (изменение яркости, 
контраста, оттенка, насыщенности), стилевые эффекты – размытие, рельеф, 
мозаика, ‘старое кино’, витраж, занимательные эффекты – рассеяние в объ-
ективе, шум, капля воды и др. 

• Добавление (заранее определенных) плавных переходов между сценами 
и/или титров.  
В Pinnacle Studio определено несколько десятков переходов (таких как ‘рас-

творение’, ‘выталкивание’, ‘слайд’, ‘спираль’ и др.). Также существуют как 
заранее определенные титры (с заголовками, пригодными для многих случаев 
жизни), так и титры с функциональностью меню (предусмотрен прямой пере-
ход к заданной части видеофильма). 

• Озвучивание фильма; при этом могут использоваться как записанные мик-
рофоном камеры звуки, так звуки из специально подготовленных аудио-
файлов,  возможно их наложение (микширование). 

В Pinnacle Studio предусмотрено использование в качестве синхронного 
звукового сопровождения использование как внешних аудиофайлов, так и 
запись с микрофона и богатая библиотека стандартных звуков; аудиоэффек-
ты позволяют выполнить как подавление шумов, так и имитацию искажений, 
эффект караоке, эхо и др. 

 
Конечным этапом является создание готового видеоролика (режим ‘Вывод 

файла’); возможны режимы записи на магнитную ленту, видеодиск, на сайт 
http://StudioOnline.com производителя в формате MPEG или вывод фильма в 
AVI-формате на жесткий диск и др. 

 
5.3 Необходимое оборудование – IBM PC-совместимая ЭВМ с процессором 

P5 или Amdahl с частотой не менее 1,5 ÷ 2 GHz, размером  ОП не менее 512 
Mбайт и жестким диском объемом не менее 80 ÷ 120 Gб, предустановленные 
ОС, набор драйверов MPEG-2, пакет Pinnacle Studio версии не ниже 9.0.  

 
5.4 Порядок проведения работы. Студент знакомится с общими сведения-

ми по практике получении видеоизображений и их цифровой обработке, под 
руководством преподавателя подключает видеокамеру к ПЭВМ (видеомате-
риал обычно снимается на камеру заранее), выбирает подходящий видео-
формат, оцифровывает данные и проводит их начальную обработку (‘выреза-
ет’ явно неудачные фрагменты,  разбивает видеоклип на сцены, сохраняет 
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сцены в отдельных файлах для последующего их использования для создания 
полноценного видеофильма). 

 
5.5 Оформление отчета по работе. Отчет должно содержать технические 

параметры видеокамеры, кабеля связи и используемой ЭВМ. В процессе 
оцифровки фиксируются параметры полученного видеоролика (формат видео 
и аудиопотока, занимаемое клипом место на диске и др.).  
Полученные в результате оцифровки и  предварительно редактированные 

сцены  предъявляются для просмотра и оценки выполненной работы. 
 

5.6 Вопросы для самопроверки. 
 

• На каком основном принципе основано восприятие человеком видеоинфор-
мации? 

• Какими количественными характеристиками определяется качество цифро-
вого видео? 

• Назвать методы снижения потока данных при работе с видео. В чем их пре-
имущества и недостатки? 

• Какие интерфейсы обычно используются для передачи файлов изображе-
ний? 

• Что такое качество VHS и DVD? 
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6 Лабораторная работа 6.  Создание видеофильмов 
 

6.1 Цель работы – приобретение практических навыков в создании цифро-
вых видеофильмов любительского уровня с помощью цифровых компьютер-
ных технологий. 

 
6.2 Теоретические основы. Создание художественного произведения (в 

том числе видеофильма) является творческим процессом, трудно поддаю-
щемся  алгоритмизации [4]; поэтому здесь рассматривается в основном тех-
ническая сторона создания видеофильма уровня ‘домашнего видео’. 
Исходными являются видеоклипы, снятые и оцифрованные согласно 

имеющегося (в виде твердой копии или в сознании режиссера) сценария. Не-
посредственно при создании видеофильма первым этапом является разработ-
ка монтажного листа (списка сцен и титров с указанием желаемой длитель-
ности, особенностей монтажа и др.). В таблице 6.1 приведен монтажный 
лист, реально использовавшийся при создании видеофильма о вручении ди-
пломов выпускникам кафедры ИТ-4 МГУПИ 03 июля 2003 г. (титры подго-
тавливались заранее в виде BMP-файлов, звуковые файлы брались из различ-
ных источников). 

 
Таблица 6.1.— Таблица-монтажный лист видеофильма                            

 
NO  
NO 

Вводной титр (включая визуальные  
эффекты), видеоклип 

Содержимое  
титра или клипа 

1 • 001.bmp 
• Вступление, о чем фильм | Информация об ав-
торе 

• aa_001.wav (звук щелканья клавиш и писк ди-
намика ЭВМ) 

• Переход - наплыв 

 
 

 • class.mpg (41 сек)  
2 • Переход наплывом (2 сек) 

 
 • Перед выпускниками выступает ректор МГУ-

ПИ  
• Естественная запись с микрофона камеры с 
переходом к а11_1.wav (классика) 

• mih_01.mpg (9,2 сек), mih_02 (2,05 мин), 
mih_03.mpg (11,2 сек) 
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3 • 004.bmp 
• Переход – всплывание из глубины 

 

 • Приступаем к вручению дипломов. Акценти-
ровать внимание - несколько человек не яви-
лись за своими дипломами! 

• Естественная запись с микрофона камеры с 
переходом к a12_3.wav  

• prize_01.mpg (1,33 мин), prize_02 (1,03 сек), 
prize_03 (1,02 сек) 

 

4 • 009.bmp 
• ‘…Довьерьяй, но провьерьяй !’ 
• Переход – всплывание из глубины 

 
 • Естественная запись с микрофона камеры с 

переходом к a13_1.wav (очень медленный 
блюз) 

• test_01.mpg (9 сек), test_02.mpg (21 сек), 
test_03.mpg (8,2 сек) 

 

5 • ta_001.bmp 
• Изображение для вставки перед концом филь-
ма 

  
 • Естественная запись с микрофона камеры 

• end_01.mpg (9,24 сек) 
 

… … … 
22 • 000.bmp 

• Конец фильма… 
• aa_001.wav (щелканье клавиш и писк динами-
ка ЭВМ) 

• Переход – плавное проявление 
 

23 • 000_.bmp 
• …Еще не совсем конец фильма 
• Звук – тот же (без прерывания) 
• Переход – такой же  

24 • 000__.bmp 
• Настоящий конец фильма 
• Звук – плавное микширование к ‘Оде к радо-
сти’ 

• Переход – ‘всплывающее солнце’ 
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6.3 Необходимое оборудование – IBM PC-совместимая ЭВМ с процессором 
P5 или Amdahl с частотой не менее 1,5 ÷ 2 GHz, размером ОП не менее 512 
Mбайт и жестким диском объемом не менее 80 ÷ 120 Gб, предустановленные 
ОС Windows, набор драйверов MPEG-2, пакет Pinnacle Studio версии не ме-
нее 9.0.  

 
6.4 Порядок проведения работы. Студент обдумывает сценарий будущего 

фильма, проводит видеосьемку, переносит полученный материал на ПЭВМ, 
монтирует видеоряд, добавляет звук, записывает готовый материал на DVD 
или CD (последнее возможно при длине видеофильма формата MPEG-2 до 
≈ 10 мин при разрешении 720×576 пиксел). 
Возможные тематические варианты создания видеофильмов: 
 

• Семейные праздники. 
• Встреча старых друзей. 
• Отдых на даче. 
• Летний отдых. 

 
6.5 Оформление отчета по работе. Отчет должен включать разработан-

ный сценарий видеофильма и содержать  технические параметры оборудова-
ния, с помощью которого создавался видеофильм. Смонтированный фильм 
обсуждается совместно со студенческой группой, причем обязательно фик-
сируются субъективные и объективные достоинства и недостатки работы. 
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